Important Information

Avid recommends that you read all the information in these release notes thoroughly before installing or using any new software release.

This document pertains to Release 3.5 of Avid Xpress® DV for the Windows® XP Professional operating system. This document describes compatibility issues with previous releases, hardware and software requirements, and summary information on system and memory requirements. This document also lists known issues or limitations.

If you are upgrading to Release 3.5, read about important changes to the software and hardware described in “The Windows XP Operating System” on page 5.

Contents

Symbols and Conventions .................................................. 4
Accessing the Avid Web Site and Knowledge Center ............... 4
New Features ................................................................. 5
  The Windows XP Operating System ................................. 5
  Color Correction for Avid Xpress DV ............................... 5
  DV Digital Cut Delay ................................................. 6
  DV Capture Offset .................................................... 6
  User Profiles ............................................................ 6
  Avid DV Codecs ......................................................... 6
Release 3.5 Release Notes

Hardware and Software Requirements ........................................... 7
Windows XP Requirements ......................................................... 7
   Setting Power Management for Laptops ..................................... 8
Setting the Proper Paging File ................................................. 9
System Configurations ............................................................... 10
DV In/DV Out Cards ................................................................. 10
FireWire Support ............................................................... 10
   FireWire Drives .................................................................. 10
Screen Resolution ............................................................. 11
Warning Regarding Your Application Key (Dongle) .................... 11
NTFS and Media Files ................................................................. 11
Unmount Disk Warning with IDE System Drives ......................... 12
Installing the Software ................................................................. 12
   Important Note About Installing Avid Xpress DV ..................... 12
   Registering Your Avid Xpress DV Release 3.5 Product ............... 13
   Installing the Avid Xpress DV PowerPack CD-ROM ................... 14
   Avid Xpress DV Tutorial CD-ROM Recommendation ................ 14
Customer Support ....................................................................... 15
   If You Need Help ................................................................ 15
   Technical Support Information ............................................. 15
Goodies Folder ........................................................................... 16
Cameras, Decks, and Transcoders ............................................. 17
   Black Striping Your Tape ...................................................... 17
   Dual Mode Devices ............................................................. 17
Audio ...................................................................................... 18
   Audio Sound Cards ............................................................. 18
   Sound Blaster Audigy Card ................................................ 19
      Installing the Sound Blaster Audigy Card in an
      Avid Xpress DV System ................................................ 19
   Updating Audio Drivers ....................................................... 20
   Other Audio Applications .................................................. 21
   Using an Audio Mixer ....................................................... 21
   Audio Tool Input Slider ..................................................... 21
   Avid DV Codec .............................................................. 21
Symbols and Conventions

These release notes use the following special symbols and conventions:

- A note provides important related information, reminders, recommendations, and strong suggestions.

- A caution means that a specific action you take could cause harm to your computer or cause you to lose data.

- An arrow indicates a known bug or limitation. Where appropriate, a workaround is provided.

- Courier Bold font identifies text that you type.

Accessing the Avid Web Site and Knowledge Center

To access product-related information (system specifications):

- Go to the Avid Web site:
  www.avid.com/xpressdv

To access the Avid Knowledge Center for technical tips, documentation, downloads, and camera lists:

1. Go to the Avid Web site:
   www.avid.com
2. Click Support.
3. Click Online Support.
4. Click the link to the Knowledge Center.
5. From the Knowledge Center, choose Avid Xpress DV from the Current Product menu.
New Features

The following sections list the major features that were added to Avid Xpress DV Release 3.5.

The Windows XP Operating System

Avid Xpress DV Release 3.5 is the first Avid Xpress DV release created for the Windows XP operating system.

To upgrade Avid Xpress DV Release 3.0 or earlier to Avid Xpress DV Release 3.5, you must update your Windows operating system to Windows XP.

Please review the following items:

• If you are upgrading from a previous release, you must install Windows XP before upgrading your Avid Xpress DV software.

• If you use third-party applications, make sure you have a Windows XP compliant version of the software.

• If you have added third-party cards, make sure they are Windows XP compliant before you use them with your Avid system. You might need to upgrade the associated drivers with Windows XP compliant versions.

Color Correction for Avid Xpress DV

The Avid Xpress DV software includes a set of tools for correcting and adjusting colors. These tools include easy-to-use controls that can be mastered quickly.

For information about how to use the Color Correction tool, see the Avid Color Correction User’s Guide.
DV Digital Cut Delay

The DV digital cut delay affects the timing of the DV data sent to the recording device for digital cut. Increasing the digital cut delay will cause the sequence stream to be delayed when it is sent to the DV device when the digital cut begins.

DV Capture Offset

The DV capture offset allows you to offset the incoming DV stream against the timecode assigned to each frame during recording. This offset is only used in transcoder configurations or in configurations where the DV stream does not encode timecode into the incoming DV frames.

For information about how to perform DV capture offset or a DV digital cut delay, see Chapter 7 and Chapter 18 in the *Avid Xpress DV User’s Guide*.

User Profiles

You can establish different profiles for a single user without having to log out of your system and log back in under a different name. For more information, see “Changing Users” in Chapter 2 of the *Avid Xpress DV User’s Guide*.

Avid DV Codecs

Two Avid DV Codecs are available. For more information, see Chapter 19 of the *Avid Xpress DV User’s Guide*. 
Hardware and Software Requirements

Avid Xpress DV requires the following system configuration:

- Windows XP Professional operating system
- Minimum 750-MHz Pentium® III or Pentium 4
- Minimum of 256 MB of RAM, 384 MB is recommended

*Avid Xpress DV Release 3.5 is not supported on the Windows 2000 operating system.*

To verify the version of the operating system and the available RAM:

1. Right-click the My Computer icon on your desktop, and then choose Properties.
2. Click the General tab.
   - It displays your operating system version and available memory.
3. Click OK to close the System Properties dialog box.

*Avid recommends that you download all of the Window Updates for optimum system performance.*

Windows XP Requirements

If your system already has Windows XP, you are ready to install Avid Xpress DV Release 3.5. See Chapter 2 in the *Avid Xpress DV Getting Started Guide*. If you are upgrading from an earlier Avid Xpress DV release, you must upgrade your operating system before installing Avid Xpress DV Release 3.5.

Operating system upgrades should be performed by personnel familiar with such tasks. Please contact your platform vendor or see their support Web site to determine the recommended process for upgrading your system from Windows 2000 to Windows XP.

*In some cases, your system BIOS might also need to be updated.*
Release 3.5 Release Notes

Consider the following before upgrading your operating system:

- Save critical data, including Avid Xpress DV Bins, Projects, and Media.
- Make sure you are the system administrator of the system you are updating.
- Depending on your platform vendor, you might be able to perform an upgrade to Windows XP instead of a complete operating system installation.
- Install Avid Xpress DV Release 3.5 after the system has restarted using the Windows XP operating system.

Setting Power Management for Laptops

There are issues with running Windows XP on some laptops. For example, outputting to a Client monitor or digital cut to tape might blank out.

To fix this:

- Turn Power Management to Always On:
  a. Click the Start button, and then click Control Panel.
     The Control Panel window opens.
  b. Double-click the Display icon.
     The Display Properties dialog box appears.
  c. Click the Screen Saver tab.
  d. Click the Power button.
     The Power Options Properties dialog box appears.
  e. From the Power Schemes tab, choose Always On from the Power Schemes menu.
  f. Click OK in the Power Options Properties dialog box.
  g. Click OK in the Display Properties dialog box.
Setting the Proper Paging File

When you first install the Windows XP operating system, the paging file is automatically generated based on the amount of memory in the system. If you add more memory, you need to change the paging file.

*The paging file size should be at least 768 MB. If you experience underruns while running Avid Xpress DV, try increasing the paging file size to correct the problem.*

**To change the paging file size according to the memory size:**

1. Log in to your local computer as System Administrator.
2. Click the Start button, and then click Control Panel.
   - The Control Panel window opens.
3. Double-click the System icon.
4. Click the Advanced tab.
5. Click Change in the Virtual Memory area.
   - The Virtual Memory dialog box appears.
6. Select the appropriate partition in the Drive list.
7. Change the initial and maximum paging file size under the selected disk partition.
   - The minimum and maximum paging file should be the same size.
8. Click Set.
9. Click OK to close all open dialog boxes and windows.
10. Restart the system to allow the paging file to take effect.
System Configurations

To access an updated list of supported system configurations and known issues:

1. Go to the Avid Web site:
2. Click Products.
3. Choose Avid Xpress DV.

DV In/DV Out Cards

Avid Xpress DV supports the Open Host Controller Interface (OHCI) compliant IEEE 1394 chip. For the most current list, see www.avid.com.

FireWire Support

At this time, Avid supports the use of multiple FireWire® ports and multiple devices. However, you can have only a single DV device connected to the Avid Xpress DV system at one time.

FireWire drives can be connected directly through the same qualified 2-port DV In/Out (FireWire) card used to connect DV cameras, decks, and transcoders. The DV In/Out cards and drives qualified by Avid have two FireWire connectors, allowing multiple drives to be chained together. Notebook computers with integrated DV In/Out capability only have a single port. A CardBus 1394 card is required for a second port. Depending on the 1394 devices involved, it may be necessary to isolate FireWire drives to a dedicated port.

FireWire Drives

You cannot record media on a FireWire drive formatted for Macintosh® systems and then play the media on a Windows platform. You can only record and play media on a natively formatted FireWire drive. However, you can move the media between platforms.
Screen Resolution

Avid requires the following for your system to run the Avid Xpress DV application:

- The Screen area (in the Display Properties dialog box) set to a minimum of 1024 by 768 pixels
- The Colors (in the Display Properties dialog box) set to True Color 32 bit (High Color 16 bit for systems with video cards that don’t have 32 MB of memory)
- The Refresh Frequency (in the Monitor tab of the Advanced settings in the Display Properties dialog box) set to 75 Hertz as your screen resolution

Dual-monitor systems also require a minimum Screen area of 1024 by 768 pixels.

Higher screen resolutions can be used. Screen resolutions are limited by the system’s graphics board and the monitor specifications.

Warning Regarding Your Application Key (Dongle)

The application key, commonly referred to as a dongle, allows the Avid Xpress DV software to run on your system. Protect your application key from loss or theft because your Avid Xpress DV software does not function without it, and acquiring a new application key from Avid involves a fee.

NTFS and Media Files

Avid recommends storing media on an NTFS file system. If you use something other than NTFS (FAT or FAT32), the system might not rebuild your media database under certain circumstances.

If you receive the error message “Unsupported Resolution Error” in NTSC or “Compression_Not_Supported” in PAL, you need to delete the msmFMID.pmr file.
Release 3.5 Release Notes

To delete the msmFMID.pmr file:

1. Find the file in the following location:
   
   \drive\Program Files\Avid\Avid XpressDV\SupportingFiles\Avid_MediaFiles
   
2. Select the msmFMID.pmr file, and delete it.

Unmount Disk Warning with IDE System Drives

⚠️ In the Avid Xpress DV application, do not choose Unmount Disk from the File menu if you have IDE drives. Choosing Unmount Disk causes a system error and might cause you to lose unsaved data.

For Release 3.5, the Unmount Disk command allows you to select SCSI media drives only and to make them inaccessible to Avid Xpress DV. This command does not work with IDE system drives.

Installing the Software

For information on installing the Avid Xpress DV software and other applications, see the instructions in Chapter 2 of the Avid Xpress DV Getting Started Guide.

Important Note About Installing Avid Xpress DV

After you install the Avid Xpress DV application, attach the dongle and proceed with the recommended defaults in the Hardware Wizard.

If the Avid Xpress DV application installer determines that your system does not have Windows XP operating system running on your system, Avid Xpress DV will not be installed.
Registering Your Avid Xpress DV Release 3.5 Product

You must register your product to receive important information about Avid Xpress DV; this also covers the product under its warranty.

If you register your Avid Xpress DV Release 3.5 product, you will receive the special Pan & Zoom plug-in. The Pan & Zoom plug-in allows you to import any size still image and to create video clips in real time.

To register your copy of Avid Xpress DV:

1. Start the Avid Xpress DV application.

   The Product Registration dialog box appears. This allows you to register your Avid Xpress DV product.

2. Click one of the following buttons:

   - **Register Online** — Opens a Web browser with the Avid Xpress DV Product Registration form. Fill out the form, and then click Submit.

   - **Display Registration Form to Print** — Opens the Avid Xpress DV Product Registration form that allows you to print the form, fill it out, and then mail it to Avid.

   - **Don't Register Now** — Click this button if you do not want to register your product at this time.

You can also obtain the online and printable versions of the Avid Xpress DV Product Registration form from within the Avid Xpress DV application. Choose Product Registration from the Help menu, and then choose either Register Online or Display Registration Form to Print.
Installing the Avid Xpress DV PowerPack CD-ROM

If you purchased the Avid Xpress DV PowerPack CD-ROM, install this CD-ROM after you install the Avid Xpress DV application CD-ROM.

Included on the Avid Xpress DV PowerPack CD-ROM are:

- IllusionFX™ Pack: Includes 30 effect plug-ins and the Region Stabilize effect. Documentation describing this effect is included in the Help and in the *Avid Xpress DV Online Publications* CD-ROM.


The release number change (now Release 11.1) for ALE does not mean that any major changes have occurred within the application. Avid is trying to synchronize our release numbers for our smaller applications to track them with the release of our editing systems.

- FilmScribe™: Documentation is included on the *Avid Xpress DV Online Publications* CD-ROM.

If you didn’t purchase the Avid Xpress DV PowerPack, but are interested in getting more information about this package:

- Within the United States and Canada, contact Avid Inside Sales at 800-949-2843.
- Outside North America, contact your local Avid reseller.

Avid Xpress DV Tutorial CD-ROM Recommendation

Avid recommends that you remove the Avid Xpress DV Tutorial CD-ROM from the CD-ROM drive before you start the Avid Xpress DV application.
Customer Support

The Avid Xpress DV system is supported by Avid and your PC vendor. Avid offers 30 days of installation-related phone support upon registration. You must register your Avid Xpress DV system to take advantage of this 30-day support period. For instructions on registering, see “Registering Your Avid Xpress DV Release 3.5 Product” on page 13.

If You Need Help

If you are having trouble using Avid Xpress DV:

1. Retry the action, carefully following the instructions given for that task. It is especially important to check each step of your workflow.
2. Check these release notes for the latest information that might have become available after the hardcopy documentation was printed.
3. Check the documentation that came with your Avid application or your hardware for maintenance or hardware-related issues.
4. Visit the online Knowledge Center at www.avid.com/support. Online services are available 24 hours per day, 7 days per week. Search this online Knowledge Center to find answers, to view error messages, to access troubleshooting tips, to download updates, and to read/join online message-board discussions.
5. For Technical Support, please call 800-800-AVID (800-800-2843).

Technical Support Information

Avid has built and maintains one of the largest worldwide Customer Support networks in the industry. All of Avid's Customer Support representatives are trained and certified in a broad range of applications, new operating systems, and storage and networking solutions. In addition to this highly experienced staff, Avid Resellers and Rental Companies in the major regions of the world have the capability to deliver various levels of application and hardware support direct to the end user, with the full backing of the entire Avid worldwide Customer Support organization.
Support delivery is designed to provide the most responsive service possible within the geography by adopting host-country language and customs.

In North America, Telephone Technical Phone Support is available on a pay-per-incident basis. For pricing information or to use your credit card, call 800-800-AVID (800-800-2843). You can also have the call billed to your phone by calling 900-555-3782.

For more information regarding Avid’s service offerings, visit www.avid.com/support or call Avid Sales at 800-949-AVID (800-949-2843).

Program availability and details might vary depending on geographic location and are subject to change without notice. Contact your local Avid office or your local Avid Reseller for complete program information and pricing. However, if you need help locating an Avid office or Avid Reseller near you, please visit www.avid.com or call in North America 800-949-AVID (800-949-2843). International users call 978-275-2480.

Goodies Folder

The Avid Xpress DV CD-ROM includes a Goodies folder. This folder contains third-party demos, applications, or plug-ins you can use — some of which are evaluation versions that are not fully functional.

⚠️ The information in the Goodies folder is provided solely for your reference and as suggestions for you to decide if any of these products fit into your process. Avid is not responsible for the manufacture, support, or sales of these products. Avid is also not responsible for any loss of data or time or any other adverse results related to the use of those products. All risks of using such products or accessing such Web sites are entirely your own. The Web sites listed in the Goodies folder are not under the control of Avid, and Avid is not responsible for their content, any changes or updates to them, or the collection of any personal data or information by the operators of such sites. All information and product availability is subject to change without notice.
To open the Goodies folder when the icon is not on your desktop:
1. Insert the Avid Xpress DV CD-ROM into the CD-ROM drive.
2. Click Browse CD.
3. Double-click the Goodies folder.

Cameras, Decks, and Transcoders

For the most up-to-date information on DV devices, search for “dv devices” in the Knowledge Center. To access the Knowledge Center, see “Accessing the Avid Web Site and Knowledge Center” on page 4.

If you have a problem connecting or using your DV device, check the manual that came with your DV device.

Black Striping Your Tape

Before you perform a digital cut, Avid recommends that you black stripe your tape. This allows for timecode on your tape.

For specific steps on black striping your tape, search for “black striping” in the Knowledge Center. For information on accessing the Knowledge Center, see “Accessing the Avid Web Site and Knowledge Center” on page 4.

Dual Mode Devices

Transcoders and decks with dual mode capabilities, switching between NTSC and PAL, need to power-cycle the DV device when switching between formats.

Before you switch settings:
1. Quit Avid Xpress DV.
2. On the DV device, switch to NTSC or PAL.
3. Cycle the power on the DV device.
4. Start Avid Xpress DV.
Audio

For information regarding audio, see the following sections.

Audio Sound Cards

Avid Xpress DV supports using only one sound card at a time. If your system has multiple sound cards, the system needs to know which sound card to use.

To choose an audio sound card:

1. Click the Start button, and then click Control Panel.
   The Control Panel window opens.
2. Double-click Sounds and Audio Devices.
   The Sounds and Audio Devices dialog box appears.
3. Click the Audio tab.
4. Select “Use only default devices.”
   The Default device for Sound Playback and Sound Recording should display the same device.
5. In the Sound Playback area, click Advanced.
   The Advanced Audio Properties dialog box appears.
6. Click the Performance tab.
7. Drag the Hardware acceleration slider to Full.
8. Click OK.
9. In the Sound Recording area, click Advanced.
   The Advanced Audio Properties dialog box appears.
10. Drag the Hardware acceleration slider to Full.
11. Click OK.
Consumer audio cards exhibit differences with the phasing and polarity of the audio signal. Tolerances will vary with each brand of card. These limitations are inherent to the hardware and will display in all applications that play audio through the card.

Sound Blaster Audigy Card

This workaround was supplied for the Avid Xpress DV Windows 2000 Operating system. It has not been tested for the Windows XP operating system. The workaround should still apply.

If you are using a Sound Blaster® Audigy card with Avid Xpress DV, after a few minutes of play, the sound will no longer be heard through the card output. The only way to fully restore the output is to quit and reboot the system. Avid has traced this problem to the Sound Blaster Audigy driver installation. Use the following instructions to install your Sound Blaster Audigy card.

Installing the Sound Blaster Audigy Card in an Avid Xpress DV System

To install the Audigy card:
1. Shut down your system.
2. Install the Sound Blaster Audigy card into an open PCI slot.
3. Start your system.
4. Log in.
   The Hardware Wizard should have found the new hardware.
5. Insert the Sound Blaster Audigy Installer CD-ROM that came with the Audigy card but do not run the installer application.
6. Use the Hardware Wizard to browse the Installer CD-ROM for an appropriate audio device driver.
7. Use the Hardware Wizard to install the audio device driver found on the Installer CD-ROM.
8. Restart the system when prompted.
Release 3.5 Release Notes

9. Log in.

The Hardware Wizard might run again, trying to install a driver for the game port.

10. Use the Hardware Wizard to search the Installer CD-ROM for an appropriate game port driver.

11. Use the Hardware Wizard to install the game port driver that is found on the Installer CD-ROM.

*The installer that comes with the Audigy card includes many applications and installers. Some of these applications will not run with the driver installation previously described. Install these at your own risk. The specific applications that might have a conflict are Creative TaskBar and EAX™ Audio Effect Controls.*

Updating Audio Drivers

You need to update your audio driver to a newer version if you receive the following error or exception messages when you start the Avid application or initialize audio:

- Can’t find any audio cards in your system. You will not be able to play audio.
- WIN32MIXER when you initialize audio

If you have a sound card that you use for audio, go to the sound card manufacturer’s Web site and search for the most recent audio driver for Windows XP for that card.

If you are using the onboard audio chip in your computer, go to the computer manufacturer’s Web site and search for the most recent audio driver for your computer model for Windows XP.
Other Audio Applications

To avoid contention over system audio resources, do not start any other audio application while running the Avid Xpress DV application. If you want to use a CD-ROM player, use the cdplayer.exe file supplied with your system.

To start the cdplayer.exe:
1. Click the Start button, and then click Run.
2. Type `cdplayer`, and then click OK.

Using an Audio Mixer

When using an audio mixer with Avid Xpress DV, you should use shielded audio cables to connect the mixer to your computer. If you don’t use shielded audio cables, excessive noise might occur in the audio output during audio scrubbing.

Audio Tool Input Slider

The Input slider in the Audio tool does not have a scale on it. The unity gain point is correct only for an analog line, not for a CD-ROM, microphone, or the IEEE 1394 standard FireWire. The slider cannot be used to completely silence audio; the hardware does not have enough range to do this. Therefore, the lowest value on the slider is not equal to minus infinity.

Avid DV Codec

Avid Xpress DV uses the new Avid DV codec as the default. For the best image quality, use the Avid DV codec whenever possible. The Avid DV codec requires a license key (dongle).
Recommended Workflow for Installing the Free DV25 Codec and Exporting Media to a Non-Avid System

To share media between Avid Xpress DV and other third-party products, you need to install the QuickTime compatible codec included in the Goodies folder on Avid Xpress DV application CD-ROM. The version installed by default is used to decode only, to allow for a high-performance import of Avid’s media with other products. The version included in the Goodies folder will provide the ability to use Avid’s high-quality encoder with third-party products. This codec can also be used on non-Avid systems as well.

To install the free DV25 codec (on an Avid or non-Avid Windows system):

1. Find the file in the following location on the Avid Xpress DV application CD-ROM:
   
   CD-ROM drive:\Goodies\AvidDV25Codec


To uninstall the free DV25 codec:

1. Find the file in the following location on the Avid Xpress DV application CD-ROM:
   
   CD-ROM drive:\Goodies\AvidDV25Codec


To export media to a non-Avid system:

1. Choose Export from the File menu.
   The Export As dialog box appears.

2. Click the Options button.
   The Export Settings dialog box appears.

3. Choose QuickTime Movie from the Export As menu.

4. Deselect the Use Avid DV codec option.
   The Apple® QuickTime® DV codec will be used automatically once the Avid DV codec is deselected.
Third-Party Software

With Avid Xpress DV Release 3.5, Avid has included third-party software to enhance your videos. To run these applications, follow the instructions on the CD-ROM provided to install the software. On some of the third-party CD-ROMs, online documentation might be provided.

For questions or technical support regarding the various third-party software applications, contact the appropriate vendor.

Uninstalling Previously Loaded Third-Party Applications

Before reinstalling any third-party application, you need to manually uninstall first.

1. Click the Start button, and then click Control Panel.
   The Control Panel window opens.
2. Double-click Add/Remove Programs.
   The Add/Remove Programs dialog box appears.
3. Locate the application you want to uninstall, and click Change/Remove.
4. Follow the instructions.
5. Click Close.

Uninstalling the Avid AVI Codec

If you have the Avid AVI Codec previously installed on your system (from an earlier release of Avid Xpress DV), you need to manually unistall this codec before installing the Avid Xpress DV application and the new Avid AVI Codec.
Suggestions for Optimum Performance

Windows is a multitasking operating system. However, background tasks can interrupt time-critical operations, such as recording, playing, or rendering. Make sure that background tasks are not running while you are working in the Avid Xpress DV system.

The following list contains suggestions for ensuring optimum performance when working with the Avid Xpress DV system:

- Do not leave a Windows Explorer window open.
  Windows Explorer will try to update file information.
- Do not leave other applications open.
  Some applications, such as Microsoft® Office, run background processes.
- Do not leave an e-mail application open if it is set to do periodic checks for mail.
- Do not schedule automatic backups at times when your Avid Xpress DV system might be in use.
- Do not start any application that includes prescheduled or automatically scheduled activities, such as a calendar program.
- Do not keep antivirus software running in the background.
  Some antivirus software will try to scan media files while you are recording. This might cause underruns or other application problems with Avid Xpress DV.
- Do not use large graphics as wallpaper.
- Do not allow the Find Fast background process (find.exe) to run.
  The process will try to update its cache of file and folder locations. Check your Startup folder and delete the file if it is there.
- Disable screen savers.
- Do not transfer network data during critical operations.
- Do not insert a CD-ROM in a CD-ROM drive during time-critical operations.
Most CD-ROM drives and software perform an autoscan or autostart operation. The Avid Xpress DV system is shipped with autostart disabled.

- Always use small fonts to avoid missing characters in the application dialog boxes. To review font settings, right-click the desktop and then choose Properties. Click the Settings tab in the Display Properties dialog box, and then click Advanced. Choose Small Fonts from the Font Size list.
- Deselect all Visual effects options in the Effects tab of the Display Properties dialog box.
- Disable the Microsoft Office Shortcut Bar. When this feature is enabled, the top of the Avid Xpress DV windows get covered by the Microsoft Office Shortcut Bar.

**Documentation for Release 3.5**

The Avid Xpress DV package you purchased determines the documentation you receive and whether it is delivered in printed format, online format, or both. The following list describes the Avid Xpress DV documentation for Release 3.5.

- *Avid Xpress DV Release 3.5 Release Notes for the Windows XP Operating System*: This document, which includes known issues, important information, and any last-minute changes.
- *Avid Xpress DV Release 3.5 Release Notes for Mac OS X*: Includes known issues, important information, and any last-minute changes.
- Avid Xpress DV Help: Includes all procedures and features for this release.
- *Avid Xpress DV User’s Guide Supplement (online only)*: Includes supplementary editing information.
Release 3.5 Release Notes

- *Avid Xpress DV Effects Guide (online only)*: Includes information and procedures about the effects included with Avid Xpress DV.
- *Avid Color Correction User’s Guide (printed in black and white — the online version is in color)*: Includes information and procedures about Avid’s color correction tool.
- *Avid Xpress DV Quick Reference Card for Mac OS X*: Keyboard shortcuts for the Avid Xpress DV system on a Mac OS X system.
- Avid Xpress DV Tutorial CD-ROM: Includes the media and project folder you will need to go through the step-by-step tutorial included in the *Avid Xpress DV Getting Started Guide*.
- *Avid Xpress DV Online Publications CD-ROM*: Includes a .pdf file of each Release 3.5 manual available with Avid Xpress DV. Also available on this CD-ROM is a complete glossary of Avid editing terms, a document of supplementary editing information, a document about the IllusionFX plug-ins, the Avid Xpress DV Help, the Avid EDL Manager Help and *Avid EDL Manager User’s Guide*, the Avid FilmScribe Help and *Avid FilmScribe User’s Guide*, and a quick and easy tour that describes the basics steps to edit video with Avid Xpress DV.

**Avid Xpress DV Online Publications CD-ROM Change**

The following section documents changes to the *Avid Xpress DV Online Publications* CD-ROM that occurred after the CD-ROM was completed.
Viewing QuickTime Movies from the Avid Xpress DV Effects Guide

The Avid Xpress DV Effects Guide located on the Avid Xpress DV Online Publications CD-ROM contains QuickTime movies that demonstrate many effects in the “2D Effects Reference” chapter. If you double-click a movie link and the QuickTime Movie Player does not appear, you should install Acrobat Reader version 5.0.5. We’ve included the version 5.0.5 installer in the Acrobat folder on the Avid Xpress DV Online Publications CD-ROM.

For more information on playing the movies, see the Using This Collection document on the Avid Xpress DV Online Publications CD-ROM.

Avid Xpress DV User’s Guide Changes

Appendixes A, B, and C that appeared in the Release 3.0 Avid Xpress DV User’s Guide are now included in the Avid Xpress DV User’s Guide Supplement on the Avid Xpress DV Online Publications CD-ROM. This information is also included in the Help.

Unmounting Drive Error in User's Guide

The Avid Xpress DV User's Guide incorrectly states that to unmount a drive, you should click Unmount. The step should read, click Eject. The Help has the correct procedure. The following procedure includes the corrected steps.

To unmount a disk or to make a drive unavailable to Avid Xpress DV:

1. With the Avid Xpress DV application active, choose Unmount from the File menu.
   The Select a Drive dialog box appears. The scroll list displays all drives currently available.
2. Select a drive to unmount. Ctrl+click to select additional drives, or click All to unmount all the drives.
3. Click Eject.

The drives are no longer available to Avid Xpress DV.
Avid Color Correction User’s Guide Changes

The following section documents changes to the Avid Color Correction User’s Guide that occurred after the manual went to print.

Waveform and Vectorscope Commands

On page 86 of the Avid Color Correction User’s Guide, it currently states that “the waveform and vectorscope commands, found in the Source menu, configure the monitor to graphically display color information about your sequence. The system displays the information for the currently active monitor.”

This should be changed to read:

“The waveform and vectorscope commands, found in the Source menu, configure the monitor to graphically display color information about your sequence. The system displays the information for the image in the Current monitor.”

The change means that the procedure for displaying a waveform monitor or vectorscope should read:

To display a waveform monitor or vectorscope:

1. Choose Current from the Source menu of one of the monitors.
   
   The monitor becomes the Current monitor.

2. Move the position indicator to the image for which you want the information.

3. In one of the other monitors, click the Source menu and choose a waveform or vectorscope command.
   
   The monitor displays the selected waveform or vectorscope information.

4. Move the position indicator to display information for other images.
Avid Xpress DV Effects Guide Changes

Below are changes to the *Avid Xpress DV Effects Guide* that occurred after the manual went to print.

Real-Time Effects

Avid recommends that you always render with real-time effects enabled in the Timeline.

Additional Notes on Operation

This section describes issues we’ve encountered with Avid Xpress DV.

For specific issues with DV devices, check the Knowledge Center. To access the Knowledge Center, see “Accessing the Avid Web Site and Knowledge Center” on page 4

Audio

- Dragging the position indicator during audio scrub (Caps Lock) causes audio underruns to appear in the Source and Record monitors.

- Playing long sequences or loop playing on a system equipped with the SoundMAX® Audio chip might result in audio underruns.

- When using the Yamaha® SXG driver, you might experience audio hardware underruns when playing back audio.

**Workaround:** Quit Avid Xpress DV and set the preferred playback device to Sound Max Digital Audio.

1. Click the Start button, and then click Control Panel.
   
   The Control Panel window opens.
2. Double-click Sounds and Audio Devices.
   The Sounds and Audio Devices dialog box appears.
3. Click the Audio tab.
4. In the Sound Playback section, choose Sound Max Digital Audio from the Preferred device pop-up menu.
5. Select “Use only default devices.”
6. Click OK.

➤ When you play a calibration tone to both the camera and the consumer audio line (DV OHCI/1394) output, the frequency of the tone heard on the consumer line will change.

Workaround: If you are calibrating the audio going to the DV OHCI/1394 line, listen to the output through the camera, rather than the consumer audio line output.

To disable the output to the camera:
1. Click the Settings tab in the Project window.
   The Settings scroll list appears.
2. Double-click Video Display.
   The Video Display dialog box appears.
3. Deselect “Don’t send video to DV device (Client monitor disabled)” option.
4. Click OK.

➤ You might experience excessive noise when connecting your computer headphone output to outboard audio equipment, such as a studio mixer or powered loudspeakers. This is due to the signal grounding arrangement in both the external audio hardware and in the computer, and is especially apparent on some laptop models.

Workaround: Use a ground-loop isolator, available at RadioShack (part # 270-054), between the computer headphone output and the outboard audio equipment.
Additional Notes on Operation

Color Correction

➤ Using the Color Correction tool to add correction to a clip, changes the name of the clip to “Color Correction.”

Digital Cut

➤ An exception error occurs when you perform a digital cut with chained FireWire drives.

➤ Most Sony® brand DVCAM™ devices will break the solid timecode on the tape after the tape is used for a digital cut.

  Workaround: Add black to the beginning and end of the sequence before recording.

➤ When you work in PAL, the Laird FFP transcoder outputs very poor quality analog video.

➤ You cannot perform an audio-only digital cut longer than 10 minutes.

  Workaround: Include video in the digital cut.

➤ Inaccurate timecode occurs when you use mixed frame rates (non-drop-frame and drop-frame) and DVCAM recording format.

DV Devices

➤ Digital cut and recording might be inconsistent when you use a transcoder.

  Workaround: Use the DV Digital Cut Delay or the DV Capture Offset feature to achieve the correct offset.
Editing

➤ The printed keycap labels supplied with your Avid Xpress DV system display four incorrect labels. The keys Y, U, P, and H are incorrect. The Y, U, and P keys do not have any commands associated with them, and the H key should be Add Edit.

Effects

➤ With Real-Time Effects disabled, if you place a transition on a motion effect and then play the sequence, an error message: PGLUE_SAMPLE_NUM_OUT_OF_RANGE occurs. This occurs for all motion effects except when you choose Duplicated Field in the Motion Effect dialog box.

In addition, with Real-Time Effects enabled, if you export a sequence as QuickTime or AVI with a transition effect on a motion effect, an “Unable to export bin” error occurs.

Workaround: Render the transition and motion effect with Real-Time Effects enabled.

➤ You need to have the position indicator on the transition point when removing a dissolve with the Remove Effect button.

➤ If you have Real-Time Effects enabled, parking on some AVX™ plug-in effects causes the effect to display incorrectly.

Workaround: Render the effect or disable Real-Time Effects.

➤ If you change the name of a motion effect clip, export it, and then import it into another system, the clip will retain its original name. It does not retain the changed file name after import.
Export

➤ An access violation occurs when you export as AVI, DV Stream, or QuickTime Movie format with an unrendered picture-in-picture effect in the sequence.

Workaround: Render all effects before exporting.

➤ An OMFI export will fail with a sequence that has an image effect clip at the start of the sequence. This is due to the 2-GB file size limit.

➤ When you export a QuickTime DV stream file at 32 kHz, make sure you select “Audio format locked” in the QuickTime Codec Options dialog box. If you don’t, you will have audio dropouts when you play the file in the QuickTime Player.

Import

➤ Video is gray when you import an OMFI 2.0 file that contains a moving picture-in-picture.

➤ While logged in as a Power User, limitations occur when you import from a CD with multiple SCSI or IDE CD drives connected. Power Users will be limited to the drive with the highest bus ID for CD import. Avid Xpress DV will not prevent you from selecting a track from a CD (with a lower bus ID drive), but when you try to import the track, a dialog box appears informing you which drive to use.

Power Users cannot import audio from a CD with FireWire CD drives.

➤ White frames display when you batch import an offline sequence that contains a consolidated QuickTime movie.
Hardware

➤ The SIIG Cardbus Dual 1394 and the Sony AJ-D250E deck are not compatible with PAL 4:1:1. The SIIG card and the deck run in different power modes.

Workaround: Use an ADS 1394 adapter, or install a 1394 hub between the SIIG OHCI board and your AJ-D250E deck.

Media Files

➤ If the Media tool opens with a drive selected, it isn’t selected properly.

Workaround: You need to select the drive again.

➤ Media files deleted from the OMFI MediaFiles folder (located outside the application) do not display as “Media Offline” properly.

Workaround: Delete the .pmr and .mbd files and restart the application for the offline functionality to work properly:

1. Quit the Avid Xpress DV application.
2. Locate the OMFI MediaFiles folder.
3. Delete the .pmr and .mbd files.
4. Start the Avid Xpress DV application.

The media database rebuilds when you start the application.

Playback

➤ Underruns might occur when you first play your sequence. This might occur when you first try to play a sequence with Real-Time Effects enabled, performing a digital cut, working with the audio tools. This is caused from the operating system loading unused data.
Workaround: Increase the amount of RAM, and then play the sequence a second time. Make sure that your system is optimized for programs instead of cache.

➤ You can’t use the L key for variable-speed play (3x or 4x) when the Record tool is open.

➤ The Dell® 330 system with an NVIDIA® display card installed plays back a flash of distorted video periodically.

Project

➤ You might encounter a long delay when switching projects. This occurs when your opened project is saved while in the Record toolset.

Workaround: Before closing your project, switch to a different toolset, and then open the new project.

Recording

➤ You might hear noise and clicking after pausing the camera in the Record tool. This is a problem with DirectShow®, but does not affect recorded material

➤ The Panasonic® AG-DVC10 is not recognized by DirectShow.

➤ Recording across timecode breaks sometimes fails when you use a transcoder.

➤ Video and audio might stutter during passthrough recording.

➤ Autosync with Source timecode does not work properly when you record through a transcoder. The audio and video are out of sync.
Release 3.5 Release Notes

➤ If you autosync two clips by IN point (one video clip and one audio clip), but no IN point has been set, the video and audio sync will be off by one frame.

Workaround: Go to the head of the clip and set an IN point.

➤ Line levels record very loud when the default of +20 dB Gain is used.

Workaround: In the Audio tool, select the +20 dB Gain check box above the Input slider.

Third-Party Applications

➤ Importing a QDesign Music 2 file, formatted as a QuickTime movie, plays back with stuttering audio at the end of the sequence.

➤ Preview is not available with many of the AudioSuite™ plug-ins due to the limited sample rate with which they can perform a preview.

➤ Exporting to a QuickTime 5.0 file with the pan set to the extreme left or right splits over both channels. This is apparent only on a Dell Precision Workstation 330.

Workaround: Disable the Stereo Wide feature.

To disable the Stereo Wide feature:

1. Click the Desktop.
2. Double-click the Speaker icon located in the bottom right corner of the Desktop.
   The Play Control Panel dialog box appears.
3. Click Options, and then choose Properties from the menu.
4. Make sure the Playback option is selected.
5. Click the Stereo Wide option to select it.
6. Click OK.

7. Close the Play Control Panel dialog box.

➤ **Running more than one application at a time causes errors.** Most video applications create a DirectDraw® overlay surface, which writes video. DirectDraw allows only a single overlay surface to exist at one time. A video application would have to stop running before a second video application starts.

**Workaround:** When running both Avid Xpress DV and QuickTime 5.0 at the same time, play the video all the way through to the end in QuickTime. This allows the appropriate resources to release from QuickTime in order to run Avid Xpress DV.

➤ **Using the headphone output on the Sony VAIO inverts the polarity.**

➤ **If a JVC® device is not running when you arm a track (video or audio) in the Record tool, the JVC device cannot send data to the 1394 FireWire.** When you play from the deck controls in the Record tool, the JVC device plays and displays video on the JVC device; however, you do not see or hear anything on the desktop. If you click the Record button in the Record tool, you receive an error message that there is no signal data.

**Workaround:** Turn on the JVC device before arming any tracks in the Record tool.

➤ **A RealMedia™ file having two periods in a row in the file name causes RealPlayer® 7 to crash when you play a file exported from Avid Xpress DV.**

**Timeline**

➤ **The audio meters in the Timeline do not update when a DV device is connected to the Avid Xpress DV system.**

**Workaround:** Use the audio meters in the Audio Tool.
The contents of windows repainting occurs during a digital cut and recording. This is caused by switching in and out of Avid Xpress DV with certain windows open.

Workaround: Disable visual themes in Windows XP.

To disable visual themes in Windows XP:
1. Locate drive:\Program Files\Avid\Avid Xpress DV.
2. Right-click the Avid Xpress DV.exe file.
   The Properties dialog box appears.
3. Click the Compatibility tab.
4. Deselect Disable visual themes.
5. Click OK.
   This turns off the Luna interface for the Avid Xpress DV application.
Release 3.5 Release Notes

States and/or other countries. Sony is a registered trademark and DVCAM is a trademark of Sony. Sound Blaster is a registered trademark and EAX is a trademark of Creative Technology Ltd. in the United States and/or other countries. SoundMAX is a registered trademark of Analog Devices, Inc. Yamaha is a registered trademark of Yamaha Corporation of America. All other trademarks contained herein are the property of their respective owners.